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Introduction 
 

General 
Flexiboard is a programmable alternative keyboard with a built-in in overlay detection. 
 
With Flexiboard you create your own keys. The keys can be letters, words and pictures and are 
placed on paper overlays. When pressing a key on the overlay, the computer responds in the 
way you have decided, for example by showing a picture on the screen. 
 
Built-in optical overlay detection means that overlays put on the Flexiboard are automatically 
detected. Exhange of overlays is done without giving any commands to the computer. 
 
The Flexiboard can be adapted for persons with different disabilities in order to facilitate an 
independent computer use. It is especially well suited for persons with cognitive disabilities.  
 
It is very easy to create your own overlays with the Flexiloader program. When creating an 
overlay you define the layout – the look of the keys on the overlay- and the command – what 
will happen when the keys are pressed on the Flexiboard. 
 
A command can be one or several presses on the ordinary keyboard. It can contain letters and 
numbers and keys like <Delete> and <Return>. It can also contain key combinations like 
<Ctrl+A>. The command can contain a series of key presses. This means that actions that 
normally would take several key presses, e.g. showing a picture or starting a program, can be 
handled by pressing one single key on the Flexiboard. 
 
The Flexiloader program is used for printing out the overlays. The printout will get the optical 
code that is necessary for the overlay detection.  
 
The Flexiboard settings, such as pressure sensitivity and repetition parameters, can be 
customized in many ways. This, in combination with being able to define the size of the keys 
make it possible to adapt Flexiboard for persons with different kinds of motoric disabilities. 
 
The Flexiboard functions with all programs that can be controlled from the keyboard. There are 
also a number of program that are specially designed for the Flexiboard, e.g FlexiWord, 
FlexiView and FlexiFind. 
 
The three first chapters in this manual are essential; “Introduction”, “Getting started with the 
Flexiboard” and “Getting started with the Flexiloader”. These chapters should be read to get the 
basic knowledge of the Flexiboard. The rest of the manual is more like a ”Reference book” and 
should be used to get a deeper knowledge of the Flexiboard or more information on a specific 
functionality. 
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Flexiboard – Description 
 
The Flexiboard consists of the following parts: 
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Software for the Flexiboard - Description 
The following programs come with the Flexiboard: 
 
FlexiUSB 
The FlexiUSB program contains the majority of the Flexiboard functions and handles the 
communication between the computer and the Flexiboard. The program runs automatically in 
the background when the computer is started.  
 
Flexiloader 
The Flexiloader program is used for creating overlays, printing out the overlays and loading 
them into the Flexiboard. The Flexiloader also contains a number of Standard Overlays, see 
Standard overlays on page 21. 
 
Demo Image Databases 
The Demo Image Databases contain a limited number of images from the following image 
databases: 
• Pictogram 
• Bliss 
• PCS  
• Food  
 
 

Computer Requirements 
Flexiboard can be run on a PC with Windows 98 SE (Second Edition), Windows 2000 or 
Windows XP. The computer must have a USB port. At least 20MB of free space on the hard 
drive is required. 
 
 

Installation 
The installation program will install Flexiboard and its software. Required drivers for the USB 
port will be installed if necessary. 
To install Flexiboard: 
1. Do not connect the Flexiboard until later. 
2. Insert the Flexiboard CD into the CD-ROM drive. The installation program starts 

automatically.  
(If the installation does not start automatically: Click the Start button, click Run and type 
d:\install.exe. Click OK.) 

3. Click OK to start the installation. The Demo Image Database will be installed only if the 
complete versions are missing. The FlexiUSB program is placed in Windows Autostart, i.e. it 
will start automatically every time the computer is started. 

4. Connect the Flexiboard to the USB port. If the Add New Hardware Wizard comes up, the 
drivers for the USB port need to be installed. See Install the USB port on page 7. 

5. The installation is completed. Remove the CD.  
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When the installation is done and the Flexiboard is connected, the 
green LED on the Flexiboard is blinking. The FlexiUSB icon is shown 
in the activity field at the right bottom of the screen: 
(More information about the FlexiUSB program can be found in the 
FlexiUSB chapter on page 18.) 

 

 
 

 
Before you start to create your own overlays it is important to verify the position of the optical 
code. Follow the instructions in the chapter Optical code adjustment on page 42. 
 
 

Install the USB port 
If the Add New Hardware Wizard comes up when the Flexiboard is connected the USB port is 
not properly installed. Follow the instructions in the wizard. See the example below: 

 

 
The wizard will install USB Composite Device. 
 
Click Next. 

 

 
 
Click Next. 

 

 
Check the Specify a location box. Click Browse 
and choose the folder Win 98 on the Flexiboard-CD, 
i.e. d:\Win98. 

 
Click Next. 
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Click Next. 

 

 
 
Click Finish. 
 

 
The same procedure may be repeated several times for different drivers (Human Interface 
Device, Keyboard Device). 
If the computer has several USB ports it is possible that the same driver needs to be installed 
several times. 



 9 

Getting started with the Flexiboard 
Follow the instructions below to try out the Flexiboard. 
  
1. Start the computer and connect the Flexiboard. If the green LED is blinking the Flexiboard is 

properly connected and the FlexiUSB program is running.  
2. Put the Standard overlay No 101 ”Alphabet CAPITAL LETTERS” on the Flexiboard. 

When the overlay is identified the green LED starts to shine steadily.  
3. Start a word processor or any program that uses letters and numbers as input (for example 

“Windows Notepad “). 
4. Press a key on the overlay. The red LED will shine and the character will be typed on the 

screen. 
5. Put Standard overlay No 102 ”Alphabet LOWER-CASE LETTERS” on the Flexiboard. 

The green LED starts to shine steadily. 
6. Press a key on the overlay. The red LED will shine and the character will be typed on the 

screen. 
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Getting started with the Flexiloader 
This chapter gives step by step instructions on how to create a simple overlay. The overlay will 
look like below.  
 

 
 
The overlay is to be used in a word processor (for example “Windows Notepad”). When the 
YES and NO keys are pressed the words YES and NO followed by <Return> (i.e. new line) will 
be typed on the screen. 
 
 
1. Start the Flexiloader 
Start the Flexiloader. The screen have the following look: 

 

To the left sets of overlays are shown in a list. (In the example above there is only one set 
of overlays). The right list shows all overlays that belong to the selected set. (The concept 
”set” means a folder with overlays.) Each set can contain up to 100 overlays. 
 
The set “My overlays” was created during the Flexiboard installation. 
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2. Open a new overlay 
Double click on overlay no.1 at the top of the right list. 

 

If any of the Flexi programs (e.g. FlexiWord or 
FlexiView) is installed a dialog box is shown where a 
template can be chosen. 
Choose <None> and click OK.  
The new overlay is opened: 

 

 
 
3. Select squares for the first key 
Click with the left mouse button on each square that should be part of the first key. See below. 
The selected squares will be highlighted in a different colour. If a square is selected by mistake 
just click on it again. 

 

A key can also be selected by clicking the upper left square, and then press and hold the 
<Shift> key on the keyboard while clicking the bottom right square of the area. 
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4. ”Open” the first key 
Place the mouse cursor on the selected squares and click with the right mouse button. Choose 
New key in the menu that is shown. The following dialog box is opened: 

 

 
In this dialog box the layout and the command of the key should be defined. (“Layout” means 
the look of the key on the overlay, i.e. text and/or images. “Commands” means the functionality 
of the key, i.e. what will happen when the key is pressed on the Flexiboard.) Layout features are 
gathered on the left side of the dialog box and command features are gathered on the right side.  
 
 
5. Define the first key’s layout 
The key’s layout can be a text and/or an image. The key can be surrounded by a frame. It is 
possible to set the colour of the text, frame and background.  
In this example the 
layout should be a text 
with a frame. 
Type the word YES in 
the text box.  
 
Choose frame by 
selecting the frame’s 
thickness, e.g. 2. The 
higher number, the 
thicker frame.  
 
To get rounded 
corners on the frame, 
check the ”Rounded 
corners” box. 
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6. Enter the first key’s command 
The command is the functionality of the key, i.e. what will happen when the key is pressed on 
the Flexiboard.  
 

 

 
Type YES in the command 
box and press the 
<Return> key.  
 
The <Return> key is also 
called <Enter>. On some 
computers it is marked as 
below: 

 
 
 
Click OK. 

 
The first key is shown on the overlay. 
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7. Select squares for the second key 
Click on the squares that should form the second key. The squares will be highlighted, as 
shown below. 

 
 
 
8. ”Open” and define the second key’s layout 
Place the mouse cursor on the highlighted squares and click with the right mouse button. 
Choose New key in the menu that is shown. The following dialog box is opened: 
 
 
 
Type the word NO in the 
text box.  
 
 
 
 
 
 
 
Frame and Rounded 
corners are already 
chosen. 
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9. Enter the second key’s command 

 

 
Type NO in the command 
box and press the 
<Return> key.  
 
Click OK. 

 
The second key is created and shown on the overlay: 
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10. Save the overlay 
Go to the File menu and choose Save. The following dialog box is opened. 

 
Enter Yes and No as the name of the overlay. Click OK.   
 
 
11. Printing out the overlay 
Go to the File menu and choose Print. The following dialog box is opened. 

 
Click on All to print out the complete overlay, i.e. text, borders and optical code.  
Click on the Settings button to adjust the printer settings. The following dialog box is opened. 
(Due to selected printer the dialog box may look slightly different.) 
 

Size: A4 
Orientation: Portrait 

Size: A3 
Orientation: Landscape 

  

If A4 paper is chosen the overlay is printed on 2 sheets. These two sheets should be attached 
to each other with adhesive tape (the sheet with the optical code to the left). 
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Click OK to close the Settings dialog box. The dialog box Print comes up again: 

 
Click OK to start the printing. 
 
 
12. ”Close” the overlay 
Close the overlay by clicking on the ”x” at the top right of the screen. Now the right list shows 
the new overlay Yes and No. 

 
 
 
13. Test the Flexiboard 
Close the Flexiloader by clicking the ”x” at the top right of the screen. Open a word processor, 
e.g. Windows Notepad. 
Put your new overlay on the Flexiboard and wait until the green LED shines steadily. If the 
green LED continues to blink the Flexiboard cannot detect the optical code. See the chapter 
The Flexiboard cannot detect the optical code on page 48 for further information. 
Press the YES key. “YES” followed by <Return> (i.e. new line) will be typed on the screen. 
Press the NO key. 
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Flexiboard functionality 
 

FlexiUSB 
The FlexiUSB program holds a lot of the Flexiboard functionality. 
When a square on the Flexiboard is pressed on, the square number is signalled to FlexiUSB. 
FlexiUSB transforms the signal to a command (one or more key presses) and forward them to 
the active program. 
The active program receives the command as if it is coming from the ordinary keyboard. 
FlexiUSB starts automatically every time the computer is started 
(the program was placed in Windows Autostart at the installation). 
The FlexiUSB icon in the activity field at the right corner of the 
screen shows that the program is running. 

 
The FlexiUSB icon also shows whether the Flexiboard is connected 
or not.  

Flexiboard connected… 
 

Flexiboard NOT connected… 
 

 
 
 
 
 
 

When the mouse cursor is placed over the FlexiUSB icon a text 
shows whether the Flexiboard is connected or not. 
 

 

 

 

 
If an overlay belonging to the loaded set is put on the 
Flexboard and the mouse cursor is placed over the 
FlexiUSB icon, the name of the set and overlay is shown. 

 

If an overlay not belonging to the loaded set is put on the 
Flexiboard the FlexiUSB icon is crossed. (That is, an 
overlay with an optical code that is undefined in the 
loaded set) 

 
 

 
Click the FlexiUSB icon to get more information about the overlay. The FlexiUSB program is 
opened: 

 

If Flexiboard is connected and a defined 
overlay is put on the Flexiboard, 
information on that overlay is shown. 
 
The feedback, repetition and pressure 
sensitivity settings are shown. (These 
parameters are described below). 
 
 

NOTE! 
Normally it is not required to open the 
FlexiUSB program. 
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Overlay detection 
The Flexiboard detects the optical code by sending out eight InfraRed (IR) beams and sensing 
the reflection. White dots give reflection, black dots give no reflection. 
The Flexiboard then signals the overlay number to FlexiUSB. 
The FlexiUSB program returns information to the Flexiboard whether the green LED should light 
steadily or blink, see Overlay detection below. 
 
 

Status of the LEDs 
Green LED 
The green LED is blinking when the Flexiboard is properly connected and there is no overlay 
present. When an overlay is put on the Flexiboard and the code is recognised, the green LED 
shines steadily.  

Red LED 
The red LED lights up when a key is pressed (and the light feedback setting is chosen). The red 
LED also blinks shortly when connecting the Flexiboard to the computer. 
 
 

Loading the Flexiboard 
The Flexiloader program is used when loading the Flexiboard. The Flexiboard can be loaded 
with one set at the time. 
Loading means activating a set to make the overlays function with the Flexiboard. The loading 
does not mean sending information to the Flexiboard. The loading will only inform the FlexiUSB 
program which set that should be active. See FlexiUSB on page 18. 
Loading is required only when another set should be used with the Flexiboard. Changes within 
a set (e.g. created or deleted overlays) will be handled automatically by the FlexiUSB program. 
 
 

Feedback 
Feedback is the sound signal and/or light signal given by the Flexiboard when a key is pressed 
on the Flexiboard. The feedback settings are adjusted in the Flexiloader, see Feedback settings 
on page 41. 

Light signal 
The red LED lights up when a defined key is pressed on the Flexiboard and the ”light feedback” 
setting is chosen.  

Sound signal 
The Flexiboard beeps a defined key is pressed on the Flexiboard and the “sound feedback” 
setting is chosen. 
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Pressure sensitivity 
The pressure sensitivity of the Flexiboard can be altered in two ways in order to improve access 
for users with motoric difficulties. These two parameters are called Acceptance Delay and 
Bounce Lock. The pressure sensitivity settings are adjusted in the Flexiloader program, see 
Pressure sensitivity settings on page 41. 

Acceptance Delay 
Acceptance Delay means that the user is required to press the Flexiboard for a certain period of 
time before a signal is sent to the active program. This helps to prevent accidental key presses 
if the user touches the Flexiboard unintentionally or if the user drags his hand over the surface 
before making a choice. 
The following values can be set: 
Acceptance Delay (AD):  0.0, 0.1, 0.3, 0.5, 0.7, 1.0, 1.5, 2.0 seconds 
When Acceptance Delay is selected, e.g. 0.3 seconds, it will be printed on the overlay: AD: 0.3. 

Bounce Lock 
Bounce Lock means that there must be a certain amount of time between two key presses. So if 
the user accidentally double hits a key the second press will be ignored. 
The following values can be set: 
Bounce Lock (BL):  0.0, 0.1, 0.3, 0.5, 0.7, 1.0, 1.5, 2.0 seconds 
Bounce Lock cannot be selected at the same time as Acceptance Delay (as Acceptance Delay 
gives Bounce Lock automatically). 
When Bounce Lock is selected, e.g. 0.3 seconds, it will be printed on the overlay: BL: 0.3. 
 
 

Repetition 
Normally it is not desirable to repeat a command from a key. But for some commands, like 
<Delete> or <Right arrow>, the repetition functionality is useful. 
There are two repetition parameters that can be set; the delay before the repetition starts and 
the repetition rate. The following values can be set: 
Repeat Delay (RD):  0.1, 0.3, 0.5, 0.7, 1.0, 1.5, 2.0 seconds 
Repeat Rate (RR): 0.1, 0.3, 0.5, 0.7, 1.0, 1.5, 2.0 seconds 
These parameters are set for an entire overlay and can then be turned on or off for individual 
keys. The Repetition settings are adjusted in the Flexiloader program, see Repetition settings 
on page 41. 
When repetition is selected for at least one key on an overlay it will be printed out on the 
overlay: FD: 0.5  RT:0.3. 
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Standard overlays 
The standard overlays, overlay numbers 101 – 127, are always in function.  
 
The following standard overlays are defined: 
101 Alphabet CAPITAL LETTERS 
102 Alphabet lower-case letters 
103 Alphabet CAPITAL LETTERS keyboard 
107 Numbers 
108 Numeric keyboard 
114 FlexiWord: Examples 
127 Select squares from Flexiboard 
 
By using the Standard overlay no. 127, it is possible to define the keys by pressing the squares 
directly on the Flexiboard. This may be useful if an overlay was created by hand and the keys 
are to be defined afterwards. 
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The Flexiloader 
 
 

Important terms 
Overlay 
A paper sheet in A3 format which is the current keyboard layout when put on the Flexiboard. 
The overlay may look in almost any way and have keys with letters, numbers or pictures. The 
overlay can be designed and printed out from the Flexiloader program, but you can also cut and 
paste directly onto an A3 format paper sheet. However, the overlay must always be provided 
with an optical code. 
 
Set 
Folder of up to 100 overlays. The Flexiboard can be loaded with one set at the time. 
 
Template 
A ”predefined” overlay to be used as a base when creating new overlays. It is efficient to use 
templates when you are going to make several similar overlays. 
 
Standard overlay 
The standard overlays, no. 101 – 127, are always in function regardless of which set of overlays 
that has been loaded. 
 
Command 
The key combination that defines what is going to happen when a key is pressed. The 
command consists of one or several “key strikes”, at the most 256. 
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Creating overlays 
When the Flexiloader is started the following screen appears: 

 

 
 
To the left there is a list of sets of 
overlays. (In this case there is only 
one set). 
 
The right list shows the 100 
overlays that belong to the selected 
set. The names of the defined 
overlays are shown. 

 
Select the overlay that is to be created (right list). Double click to open the overlay. It will be 
opened in its own window, like “Yes and No” below: 

 
In this chapter it is described how to work with the ”open” overlay. 
 
 

Define a key 
Select the squares to be part of the key by clicking on them. If you want to deselect a square 
just click on it again. The key does not have to be rectangular but the squares have to be 
connected. (To be able to put an image or text on the key it must be rectangular.) 
 
To select a number of squares quickly and easily, click on the upper left square and then the 
square in the bottom right corner while holding down the <Shift> key on the keyboard. 
 
Click with the right mouse button on one of the squares in the key. Choose New key in the 
menu that is shown. The dialog box ”Define key” is opened: 
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In this dialog box both the layout and command of the key can be defined. Everything that has 
to do with the layout is gathered on the left side and everything that has to do with the command 
on the right side. 
In separate chapters below, it is described how to define the layout and how to define the 
command. 
 
 
The key’s layout 
The layout for a block can look different in many ways. You can specify a text and/or a picture, 
choose if you want to use a frame around the key or not. You can also set the colour of the text, 
frame and background. If you wish to use text or images the key must be rectangular. The 
layout does not necessarily have to be created in the Flexiloader. It can also be constructed by 
hand (painting/cutting/gluing).  
The next key that you create will automatically have the last selected frame, colour and text 
size. 
 

Text 

 

 
 
 
The text should be entered into the text box to the 
left. To get a new line, type <Enter>. 
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Text alignment 
The Flexiloader automatically aligns the text into the centre of the key. The position can be 
changed via ”Alignment”. The dialog box to the right is opened: 

 

 
 

You can choose where to place text on the key (top, middle or bottom). 
You can also choose if the text should be centred on the line or not. If not, it will be aligned to 
the left. 
 
 
Font 
The Flexiloader automatically calculates a suitable text size for every key. The default font is 
“Arial”. Both the font and the text size can be changed via ”Font”. The dialog box to the right is 
opened: 

  
Click ”User defined font” and choose the desired font, style and size.  
The chosen font will not be shown until you have closed the dialog box “Define key”. 
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Colour 
The default text and frame colour is black. Default background colour is white. The colour of 
text, frame and background can be changed via ”Color”.  

 

 

To set another colour than black or white, 
click the ”Select color” button. Select the 
desired colour via the new dialog box that 
has been opened. 
Note that the background colour can be 
transparent. This is important when you 
create overlays with background images, 
see Define background image on page 35. 
The correct colour will not be shown until 
you have closed the dialog box “Define 
key”. 

 
 
Image from an image database 
Select an image for the key via the ”Image database” button. The dialog box to the right is 
opened: 

  

Choose an image database. The images of the database are shown in the lower list. When 
you click on an image in the list it appears in the box to the right.  
Search for the desired image and click OK. The image is shown in the dialog box “Define key”. 

Tip! 
If you mainly use images from a specific image database it can be pre-selected. See Preselected image 
database on page 33. 
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Browse images 
Select an image for the key via the ”Browse images” button. The dialog box to the right is 
opened: 

 
 

Browse to the desired folder and image file. When clicking on the image, it is shown below.  
Click Open when the image has been selected. The dialog box will be closed and the image is 
shown in the dialog box “Define key”. 
 
Program icon 
Select an icon as an image for the key via the ”Program icon” button. The dialog box to the right 
is opened: 

 
 

Everything that is shown in the Windows Start menu is shown in this dialog box. Select a 
program and click OK. The icon is shown in the dialog box “Define key”.  
Note! The programs are shown with the same structure as in the Windows Start menu. A plus sign in front 
of the text means that it is a folder and that several programs may be gathered in the folder. Click on the 
plus sign or double-click on the text to open the folder, then select a program. 
 
Frame 

 

 
 
If the key should have a frame, choose a frame 
thickness in the list box. The higher number the 
thicker frame.  
 
If the corners of the fram should be rounded, 
check the ”Rounded corners” box. 
 
The frame colour is set via the Color button, see 
Colour on page 26. 
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The key’s command 
The command is the functionality of the key, i.e. what will happen when pressing the key on the 
Flexiboard. For example, it can be writing a word, showing a picture or starting a program. 
The different types of command are described below: 
 
Type a command 

 

Most of the commands can be typed directly into the  
Command text box. 
Functional keys, e.g. <Return> and <Ctrl+A> are 
entered by pressing the key on the regular keyboard.  
Following commands are entered by first pressing 
<Esc> and then pressing the key: 
• <Tab> 
• <Backspace> 
• <Delete> 
• Arrow keys 
• <Esc> 

 
Command to Flexi-programs 
”Command to Flexi-programs” is a special type of command that only functions in the Flexi-
programs; FlexiWord, FlexiView and FlexiFind. This command is required to be able to “write” 
with pictures and play sound files simultaneously. The “Command to Flexi-programs” button 
helps you to create these special commands. The following dialog box is opened: 

 

 
In this dialog box it is possible to combine image, text, sound, text-to-speech and video as 
follows: 
• Image (with text) 
• Image (with text) + recorded sound 
• Image (with text) + text-to-speech 
• Text 
• Text + recorded sound 
• Text + text–to-speech 
• Recorded sound 
• Text-to-speech 
• Video 
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There are some combinations that cannot be selected at the same time. For example, if image, 
text, sound or speech are selected it is not possible to select video. Nor is it possible to select 
video when sound is selected and vice versa.  
The alternatives are selected or deselected by checking and unchecking the box to the left of 
each function. (If you choose an image/text as layout before opening the “Command to the Flexi 
programs” dialog box, the selected image/text will automatically be set in the dialog box). 

Note! 
Version 1 of FlexiWord, FlexiView and FlexiFind cannot handle long file names. So when using 
version 1 of the Flexi-programs see to that the check box at the bottom of the dialog box is 
checked. 
Make “short file names” to function in version 1 of the FlexiWord, FlexiView and FlexiFind.  

Then the paths to images, sounds and videos will be converted to “short”, i.e. max 8 characters 
and not contain space etc. 

 
Image Choose an image by clicking “Image database” or “Browse images”. The image 

is selected in the same way as in Image from an image database and Browse 
images on page 26. 
When using an image from an image database the 
corresponding text-to-speech text or sound file may be 
entered. 

Select one of the alternatives. 

The setting remains the next time the “Command to 
Flexi-program” is opened. 

 

Text Type the desired text in the text box. 
Sound If a sound is to be played when the key is pressed, click the ”Browse sound” 

button to browse for the desired sound file.  
Record sound You can easily record sound via the “Record sound” button. Note! Before 

recording a sound you should see to that you have a microphone of good 
quality. The following dialog box will be opened: 

 
How to record a sound: 
1. Hold the microphone in front of the mouth.  
2. Start the recording by clicking the Record button. Speak into the 

microphone. A progress bar indicates how much time of the total recording 
session that has passed. When you are done speaking, wait until the bar 
has reached the end.  

3. Click the Play button and listen to the result of the recording.  
4. If you are not satisfied, record the sound again. If the recording session is 

too short or too long, or if the sound is not cut automatically at the 
beginning and end you need to change the settings, see below. 

5. Click OK. 
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Settings 
Set the desired sound quality:  

• Phone quality (1 kHz, 8 bits, mono) 
• Radio quality (22 kHz, 8 bits, mono) 
• Better radio quality (22 kHz, 16 bits, mono) 

Set the recording time: 2, 5, 10, 15, 20 seconds. 

You can set automatic removal of silence 
in the beginning and in the end. If this is 
chosen, you also need to define ”silence”, 
i.e. the level where the sound is cut.  

Start adjusting the silence level with the 
slide far to the left. Test record and 
listening. Move the slide to right and repeat 
the test until the sound becomes cut in the 
beginning and in the end. 

Text-to-speech Text to be read by the text-to-speech function should be typed in the text-to-
speech box. Select text-to-speech via the ”Text-to-speech converter” button. 
The following dialog box will be opened: 

 

Choose text-to-speech converter; 
”None”, ”Infovox 220”, or ”SAPI”. 
(Naturally, in order to be able to 
choose a text-to-speech 
converter there must be one 
installed.)  For SAPI converters it 
is also possible to select voice 
and make various settings via the 
“Settings...” button. 
Note! The text-to-speech 
selection is only valid for the 
Flexiloader, not the program the 
Flexi-command will be used in. 

Video If video is to be played, click the”Browse video” button. A dialog box is opened 
where you can browse for the desired video file. 

Test You can test the 
chosen 
image/text/video 
combination via the 
”Test button”. 
 
Click OK when done. 
The command string 
will be generated 
automatically and 
placed in the Command 
box in “Define key”, 
e.g.: 
@pa1@ 
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Command to start program 

  

Select the program you want to start from the Flexiboard via the ”Command to start program” 
button.  

One simple way of selecting the program is to go via 
the Windows Start menu button. A dialog box with 
all programs on the Windows Start menu is opened. 
The programs are shown with the same structure as 
in the Windows Start menu. A plus sign in front of the 
text shows that it is a folder and that programs are 
collected in the folder. Click the plus sign to open the 
folder or double click the text and then select the 
program. 
  

Another way of selecting the program is to go via the Browse program button. To do this you 
need to know in which folder the program is to be found and the name of the file. 
If the program should be started with a file or another argument, it should be stated in the 
”Start with file” text box. It can for instance be a user file or a web address (if the program is 
Internet Explorer). Choose the file via the ”Browse file” button or type it into the text box. 
When you click OK, a command is created in the dialog box ”Define key”, e.g.: 
<Win+R><Paus0.5>c:\flexview\flexview.exe<Paus0.5><Return> 

The command is constructed to work with older versions of Flexiboard. The older versions of 
Flexiboard uses the Run function in the Windows Start menu to start programs. FlexiUSB start 
the program directly without using the Run function, which gives a more reliable function. 
 
 
Pause command 
The pause command means that the Flexiboard pauses the transmission of a command. This 
may be required if the active program needs more time before continuing receiving input. The 
pause command is made via the ”Pause command” button. The following dialog box is opened: 
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Enter the length of the pause, between 0.1 and 25 seconds. 
Click OK and the command is created in the”Define key” dialog box, e.g.: 
<Paus0.5> 
 
Special command 
Some commands cannot be entered directly into the command text box by using the keyboard 
keys (see Type a command on page 28). These commands must be entered via the ”Special 
command” button. The following dialog box is opened: 

 

 
 

Choose among the following special commands: 
<Alt+Esc> 
<Alt+F4> 
<Alt+Space> 
<Alt+Tab> 
<Alt+L> 
<Alt+PrintScreen> 

<CapsLock> 
<Ctrl+Alt+Delete> 
<Ctrl+Esc> 
<NumLock> 
<PrintScreen> 
<ScrollLock> 

 

 
Repetition 

 

 
It is advantageous for some keys to have a repetition 
functionality, e.g. the “erase key”. Repetition means 
that the command is sent repeatedly while the key is 
pressed. 
Check “Repetition” if the key shall have repetition. 
 
How to set the repetition parameters is described in 
the Repetition settings chapter on page 41. 
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Preselected image database 

 

 

It is possible to preselect an image database when opening the Image database dialog box. 
This is helpful if you frequently use images from a particular image database. The preselected 
database is set via Preselected image database in the Settings menu.  
 
 
Automatic command 
Via Automatic command in the Settings menu commands can be generated automatically 
when choosing images from an image database. 
It is efficient to make “Automatic commands” if you are making keys with similar structure.  

 

 
Select "Automatic command ON" and create the automatic command as follows. Select the 
basis for the command: 

• Image text 
• Image file 
• Image code 
Enter prefix (if any) i.e. keys to be typed before the image text, image file or image code. 
Enter suffix (if any), i.e. keys to be typed after the image text, image file or image code. 
When the automatic command is saved the command will be automatically generated the next 
time an image from an image database is selected.  
For example, there is a program that use commands like “Image text” + <Return> to show 
images.  
Select “Automatic command ON”, Image text and suffix “Return” as shown below. 
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The next time an image from an image database is selected the command will be generated 
automatically: 

 
 

Copy a key 
To copy a key, click on the key to highlight it. Click with the right mouse button and choose 
Copy in the menu that is shown. Then click on the upper left corner of the area where you want 
to paste the key. Click on the right mouse button and choose Paste in the menu that is shown. 
The copy has been created. 
Keys can also be copied via “drag and drop”: First, click on the key to highlight it.Then press 
and hold both the mouse button and the <Ctrl> key. Drag the copy to its location.  
 

Move a key 
To move a key, click on the key to highlight it. Click with the right mouse button and choose Cut 
in the menu that is shown. Then click on the upper left corner of the area where you want to 
paste the key. Click on the right mouse button and choose Paste in the menu that is shown. 
The key has been moved. 
Keys can also be moved via “drag and drop”: First, click on the key to highlight it.Then press 
and hold the mouse button and drag the the key to its new location. 
 

Resize a key 
To resize a key, click on the key to highlight it. Place the mouse cursor on the border/corner that 
should be moved. The mouse cursor look will change. Press and hold the left mouse button 
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down and drag the border/corner to make the key smaller or larger. Release the mouse button 
and the key is resized. 
It is only possible to resize rectangular keys.  
 

Define background image 
A background image means an image lying “behind” the keys on the overlay. If the overlay is 
going to be a playing board or correspond to a screen dump it is often desirable to have one 
single large image and define the keys as subsets. See the example below. 

 

 
 

The large image is defined as a 
background image and is 
shown ”pale”.  

The keys are in the foreground. 
(For clarity the keys have thick 
frames..)  
 

To define background images, go to the View menu and select View background. Background 
images are defined the same way as ordinary keys, see Define a key on page 23. The only 
difference is that a command cannot be entered. 
When all background images are defined, go to the View menu and select View layout. The 
background images are shown “pale”. 
If the keys should not cover the background image, the background colour of the keys must to 
be changed to transparent, see Colour on page 26. 
 

Overview of the commands instead of the layout 
Sometimes it is desirable to get an overview of all commands on the overlay, e.g. when 
searching for errors. Go to the View menu and select View command. The screen changes as 
in the example below: 

Layout view 

 

Command view 
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Print out overlays 
To print out an overlay it should first be opened. Then go to the File menu and select Print. The 
following dialog box is opened: 

 

Printer 
Current printer. 

Print: 
All will print out the layout of the overlay plus the 
optical code. 
Optical code only will print out just the optical 
code, placed correctly on the paper.  

Grid. Will print out the grid where there are no 
keys. 

Copies Number of copies are entered. 
Settings Click here to select printer, set the 
paper size and orientation. 

 

 
When the Settings button is clicked, the 
dialog box to the left is opened.  
 
If the printer can print out A3, the orientation 
should be set to Landscape.  
If the printer only can print out A4, the 
orientation should be set to Portrait. 
 

Click OK to start the printing. If A4 is chosen, the overlay will be printed out on two sheets. The 
sheets should be attached to each other with adhesive tape (the sheet with the optical code to 
the left).  
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Handling sets and overlays 
General handling of sets and overlays is done in the first level of the Flexiloader, i.e. where you 
land when the program starts.  

 

 
To the left there is a list of all sets 
that have been created. (In this 
example there is only one set). 
 
The right list shows all overlays in 
the highlighted set. There are room 
for 100 overlays in each set. 

Here you can create new sets, open overlays for definition, move/copy overlays and sets, 
export/import overlays and sets, load Flexiboard etc. Compare with the handling of folders and 
files in the Windows Explorer. 
 
 

New set 
To create a new set go to the File menu and choose New set. A dialog box is opened. Enter a 
name for the new set and click OK. The new set is shown in the list of sets. 
 
 

Copy set 
To copy a set click on the set to be copied. Click the right mouse button. Choose Copy in the 
menu that is shown. A dialog box is opened where you should enter a name for the copied set. 
Click OK. The new set is shown in the list of sets. 
 
 

Rename sets 
To rename a set click on the set that is to be renamed. Click the right mouse button. Choose 
Rename in the menu that is shown. A dialog box is opened where you should enter the new 
name of the set. Click OK. The set is shown with its new name in the list of sets.  
 
 

Delete sets 
To delete a set click on the set that is to be deleted. Click the right mouse button. Choose 
Delete in the menu that is shown. Confirm that the set should be deleted by clicking OK in the 
message box that is opened. The set is deleted from the list. 
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Import sets from older versions of the Flexiloader 
If an older version of the Flexiloader (version 1-3) is installed on the same computer, it is easy 
to import overlays from the older version.  
Go to the File menu and choose Import set from older version. A dialog box is opened and 
shows all sets from the older Flexiloader. Mark the set you want to import and click OK. The set 
is added to the list of sets. 
If you want to add more sets just repeat the procedure. 
 
 

Load the Flexiboard 
If there are more than one set of overlays, you must see to that the set that should be used with 
the Flexiboard is loaded. The loaded set is easily recognised as it’s icon is blue instead of 
yellow. 
To be able to load the Flexiboard it must be connected. Click on the set to be loaded. Go to the 
File menu and select Load Flexiboard. A dialog box is opened where the loading should be 
confirmed. The message ”The loading is completed!” is shown. Click OK. The set is now loaded 
and functions with the Flexiboard. 
You only have to load the Flexiboard when you want to use a different set than the currently 
loaded. Changes within the loaded set (e.g. new or deleted overlays) are handled automatically 
by the FlexiUSB program. 
This means that if you only use one set, it is always loaded and you do not have to think about 
loading at all.  
 
 

New overlay 
To create a new overlay click on the set that the overlay should belong to. Double click on the 
number where you want to place the overlay (or click with the right mouse button and select 
“Open overlay”). 
If the Flexiloader is set to use templates (see Using templates on page 45) a dialog box is 
opened where a template can be chosen. 
The new overlay is opened. How to define the overlay is described in the chapter Creating 
overlays on page 23. 
 
 

Edit overlay 
To edit an overlay double click on the overlay in the list. How to edit the overlay is described in 
the chapter Creating overlays on page 23. 
 
 

Copy overlays 
To copy one or several overlays, click on the overlays that should be copied. By pressing and 
holding the <Ctrl> key on the keyboard while you click on the overlays, several overlays can be 
selected simultaneously. 
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When the overlays are selected, click with the right mouse button and choose Copy in the 
menu that is shown. Depending on how many overlays are selected, different dialog boxes will 
be opened: 
 
More than one overlay selected: 

 
 

 
When several overlays are selected the 
destination set should be chosen. 
If the current set is chosen the overlays 
will get new names and numbers 
automatically.  
If another set is chosen the overlays will 
get the same names and numbers if 
possible. 

One overlay selected: 

 

 
When one overlay is selected the 
destination set should be chosen.  
It is also possible to enter a new name 
and choose a number.  

 
 
Copy overlays with ”drag and drop” 
Overlays can also be copied with the so called ”drag and drop” function. 
Press and hold the <Ctrl> key while clicking on the overlays that should be copied. Hold the left 
mouse button and the <Ctrl> down and ”drag” the overlay to its new location. If possible, the 
overlay gets the same number in the new set, otherwise it will be placed on the first free number 
in the set. 
If one overlay has been selected it can be copied within the same set. Hold the <Ctrl> key down 
and drag the overlay to the desired number. 
 
 

Move overlays 
To move one or several overlays, click on the overlays that should be moved. By pressing and 
holding the <Ctrl> key on the keyboard while you click on the overlays, several overlays can be 
selected simultaneously.  
When the overlays are selected, click with the right mouse button and choose Move in the 
menu that is shown. Depending on how many overlays are selected, different dialog boxes will 
be opened: 
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More than one overlay selected: 

 
 

 
When several overlays are selected the 
destination set should be chosen. It is 
not possible to choose the current set. 
The overlays will get the same names 
and numbers if possible. 

One overlay marked: 

 

 
When one overlay is selected the 
destination set should be chosen.  
It is also possible to enter a new name 
and choose a number. 

 
Move overlays with ”drag and drop” 
Overlays can also be moved with the so called ”drag and drop” function.  
Select the overlays that should be moved. By pressing and holding the <Ctrl> key on the 
keyboard while clicking on the overlays, several overlays can be selected simultaneously. 
Release the <Ctrl> key but keep holding the mouse button down and drag the overlays to the 
desired set.  
If one overlay has been marked it can be moved within the same set. Just drag the overlay to 
the desired number. 
 
 

Delete overlays 
To delete an overlay, select it in the list. By pressing and holding the <Ctrl> key on the keyboard 
while clicking on the overlays, several overlays can be selected simultaneously.  

When the overlays are selected, click on the right mouse button and choose Delete in the 
menu that is shown. Confirm that the overlays should be deleted by clicking OK in the message 
box that is opened. 
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Rename overlays 
To rename an overlay select it and click on the right mouse button. Choose Rename in the 
menu that is shown. A dialog box is opened where the new name of the overlay should be 
entered. Click OK.  
You can only rename one overlay at the time. 
 
 
 

Pressure sensitivity settings 
See the Pressure sensitivity chapter on page 20 for description of the pressure sensitivity 
concept.  
The pressure sensitivity can be adjusted both for sets and for single overlays. New overlays are 
automatically assigned the pressure sensitivity for their set. However, once an overlay has been 
created you can adjust the pressure sensitivity settings for that specific overlay, without 
changing the rest of the set. 
To adjust the pressure sensitivity, click on the set/overlay where the pressure sensitivity is to be 
adjusted. Go to the Settings menu and select Pressure sensitivity per set or Pressure 
sensitivity per overlay. Choose the desired setting in the dialog box. Click OK. 
 
 
 

Repetition settings 
If repetition is set for a key the repetition parameters Delay and Rate should also be set. 
Repetition is described in the chapter Repetition chapter on page 20.  
Repetition can be set both for sets and for single overlays. New overlays are automatically 
assigned the repetition for their set.  
To adjust repetition, click the set/overlay where the repetition is to be adjusted. Go to the 
Settings menu and select Repetition parameters per set or Repetition parameters per 
overlay. Choose the desired setting in the dialog box. Click OK. 
 
 
 

Feedback settings 
See the Feedback chapter on page 19 for description of the feedback concept.  
The feedback can be set both for sets and for single overlays. New overlays are automatically 
assigned the feedback for their set. 
To adjust the feedback, click the set/overlay where the feedback settings are to be adjusted. Go 
to the Settings menu and select Feedback per set or Feedback per overlay. Choose the 
desired setting in the dialog box. Click OK. 
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Optical code adjustment 
If the position of the optical code is incorrect, the Flexiboard may not function properly. Use the 
Optical code adjustment guide in the Settings menu to adjust the printout. The guide is 
described below: 

 

 
 
 

Step 1 

Make sure that the right printer is chosen. If not, 
click ”Printer settings” and select printer. 

 

 
 

Step 2 

Print out a test page.  

 

 
 

Step 3 

Measure the placing of the code and enter the 
measurements in mm according to the figure. 

 

 
 

Step 4 

Make a new print out and check the placing of 
the code. 
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Copy overlays between computers 
To copy overlays between computers, follow the guides Export overlays and Import overlays. 
The overlays are packed into a so called zip file. Both guides are described below: 
 

Export overlays 
To export overlays, select the desired set and choose Export overlays in the File menu. The 
following guide is opened: 

 

 
 
 

Step 1 

Confirm that the selected set should be exported. 
Click Next. 

 

 
 

Step 2 

Choose the overlays that should be exported. 

 

 
 

Step 3 

Choose the files (images, sounds and videos) that 
should be exported. If some of the files already exist in 
the other computer, unmark them to make the zip file 
smaller. 
Select a file and click Test to watch or listen to its 
contents. 
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Step 4 

Choose the zip file’s path and name via the Browse 
button. The zip file can be saved on the hard disk, on 
floppy disk(s) or in a network. 
Click on Finish to save the overlays and files in the 
chosen zip file. 
 
If the zip file is to be saved on floppy disk(s) the 
required number of floppy disks is shown. Insert one 
disk at the time to be copied. 

Warning: Many sound and video files in the zip file 
require many floppy disks! 

 
 

Import overlays 
To import an overlay, select Import overlay in the File menu. The following guide is opened: 

 

 
 

Step 1 

Choose from which zip file the overlays should be 
imported. The zip file can be on floppy disk(s), a CD-
ROM or in a network.  
Click Next. The chosen zip file will be extracted. If the 
zip file is saved on a disk, insert one disk at the time. 

 

 
 

Step 2 

The overlays in the zip file are shown. Unmark the 
overlays that should not be imported. 
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Step 3 

The images, sounds and videos in the zip file are 
shown. Unmark the files that should not be imported.  
If possible, the new set obtains the same name as the 
zip file. By default the files will be saved in a sub folder. 
It is also possible to save the files with the same path as 
the original computer. 
Click Finish to import the overlays. 

 
 

Using templates 
A template is a ”predefined” overlay that can be used as a base when creating new overlays. It 
is efficient to use templates when you are going to prepare several similar overlays.  
For example, the FlexiWord program has a template with keys such as ”New line”, ”Open 
document”, ”Print” and ”Close” etc. By using this template when creating overlays for the 
FlexiWord the overlays are assigned these functions automatically. 
 

Select templates when creating a new overlay 
The Flexiloader can be adjusted so that a dialog box with templates comes up before a new 
overlay is opened for creation. If you a template is chosen the overlay is automatically assigned 
the keys of the template. 
Go to the Settings menu and check Select template when new overlay to set the template 
dialog box to open each time a new overlay is to be created. 
 

Show folder with templates 
The Flexiloader can be set so that the templates are shown in a folder in the list of sets. Go to 
the Settings menu and check the Show templates option. 
 

Create your own template 
Before templates can be created, the template folder must be shown in the list of sets, see 
Show folder with templates above. 
Create you own template as you create an ordinary overlay, see Creating overlays on page 23. 
The only difference is that the template will have no number. 
 

Make a template of an overlay 
It is easy to make a template of an ordinary overlay. First see to that the template folder is 
shown in the list of sets, see Show  above. 
Copy the overlay to the template folder in the same way as overlays should be copied, see Fel! 
Hittar inte referenskälla. on page Fel! Bokmärket är inte definierat. . The overlay is 
converted to a template. 
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Tools 
Change paths 
If the paths to images, sounds and videos are incorrect for one or several overlays they can be 
corrected by using the tool ”Change paths”. 
 
For example, when importing overlays with images from a database the paths can be incorrect. 
In the computer where the overlays were created, the path to the image database Pictogram 
was c:\imgbase\picwmf. As the path to Pictogram is c:\picwmf in your own computer, the paths 
need to be changed. Use this tool to correct all Pictograms quickly and easy. Do as follows: 
 
1. Start the Flexiloader. 
2. Select the set that contains the incorrect overlays. 
3. Go to the Tool menu and choose Change paths. The following dialog box is opened: 
 

 

 
 
 
 
 
 
 
In the list the paths (folders) to all images, 
sounds and videos of the overlay are shown. 

4. Mark an incorrect path, e.g. c:\imgbase\picwmf (see below): 
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When a path is marked it is automatically 
shown in the textbox. 
 
 

 
5. Type the correct name c:\picwmf in the textbox or choose via the”Browse” button: 
 

 

 
 
 
 
 
 
 
The correct path is typed on the same line. 
 
 

 
6. If desired, change other incorrect paths in the same way. . 
7. Click OK. The paths are changed. 
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Troubleshooting 
The Flexiboard cannot detect the optical code 
There could be a number of reasons why the Flexiboard do not detect the optical code properly: 
1. The position of the code is misplaced on the overlay.  
2. The Flexiboard cannot "detect" the black dots in the code. This problem appears with some 

ink jet printers. These printers uses unpigmented ink which is transparent for IR-detectors. 
3. The Overlay Detector on the Flexiboard is not correctly calibrated.  
 
To solve the problem: 
 
Check and adjust the position of the optical code on the overlay. See Optical code 
adjustments on page 44. 
Fill up the code with a carbonaceous felt pen, e.g. EASYRASE Whiteboard marker. The 
code can also be made detectable by photo copying the overlay. 
Calibrate the detector unit of the Flexiboard. If the Flexiboard cannot detect the Standard 
overlays, the Detector unit needs to be calibrated with the program FlexiService. 
 
 

The lower edge of the optical code is "chopped off" 
Some printers cannot print further down than about 15 mm from the bottom of the page. This 
results in ”chopped off” optical codes. The code will be recognised anyway. 
 
 

The keys in the middle are missing on A4 printouts 
No printer can print to the paper’s edge. This means that when the overlay is printed out on two 
A4 papers, there will always be a white area in the middle of the overlay. 
Avoid this problem by not defining blocks in column H. 
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